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Excel 2010 - Pivot table tips using moviebus.xls 
JOUR 772 and 472 /Chinoy 

 
Examine the database: 

 
Doing this first will save you a lot of heartache later.  For example, in the fields you would like to 
analyze, the data entered consistently?  Do you see any obviously dirty data? We’ll talk about what 
we can do with what you find.  
 
Also, notice the error flags – small green triangles in the upper left of the dates: 

 
 
If you click on one of these, you’ll see a caution message with some choices.  The problem here is 
that Excel recognizes that what appear to be dates are entered in this spreadsheet as “text” rather 
than true date cells.  They will not sort properly as a result (among other issues).   

 
 
We will leave these cells as they are for now.  There are some notes later in this handout about 
how one could fix this problem. 
 

Assign unique record numbers and define the table: 
 
Because this is a long table, we will need to split the view between top and bottom.  Click on cell 
A5 and then from the View tab, click on the Split icon.  On the right side of the screen, where there 
are now two scroll bars, use the lower one to show the bottom of the table in the lower half of the 
screen.  You should see the last row of data, Row 229 (after removing one record earlier on).  
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Type RECNO in cell F1 and 
END in cell G1.  Then type a 
1 in cell F2.  Highlight that 
cell, hold down the Shift 
key, and click on cell F229, 
the cell in the last row of the 
table:   

Leaving that 
range of cells 
highlighted, from 
the Home tab 
click on Fill and 
then Series… 

 
 
Each row of data should now have a unique record number, from 1 to 229, in column F: 

 
 

Next, highlight the whole table by clicking on cell A1 (“School”), holding down the Shift key, 
and clicking on cell G229 (the cell in the END column for the last record).  Then type Database in 
the Name Box and hit the Enter key. 

 
 

Creating a pivot table: 
 
Click on the Insert tab to find the icon that says PivotTable: 

 
 
In the Create Pivot Table dialog box, type 
Database in the text box to the right of 
Table/Range.  Leave the other defaults in 
place, including placement of the PivotTable in 
a new worksheet. 
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:  
A new worksheet appears, along with a PivotTable template and two new tabs:  Options and 
Design.   Continue to work from the Options tab, which contains PivotTable Tools. 
 

 
 
 

In the Task Pane on the right, using the Pivot 
Table field list, right-click on Trip and then 
choose Add to Row Labels. 
 
 
 
 
 
Trip will show up in the Row Labels area of the 
Task Pane …  

 
 

 
 
… and also in the rows of the pivot table. 
 
 
  

Next, we want to add something to the data area of the pivot table to show how many times 
students went on each kind of trip 
 
.Since we have seen that all records have an 
entry in the Trip field, we can use that field to 
count.  If we right-click on Trip from the field 
list, we can choose Add to Values.  
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The data will become “Count of Trip.” 

 

 
 

In the data area of the pivot table, we now see 
each type of trip that appears in the Trip 
column and the number of times that type of 
trip was taken. 
 
Do you see a problem here? 
 

 
 
The pivot table, in summarizing by the Trip column, should show us each type of trip once.  But on 
the surface, it looks like we have some types of trip that appear in this pivot table list more than 
once. For example, the word movie appears three times (that is, it is listed on three of the rows in 
the pivot table).  What might be causing this? 
 

 
~~~~~~~~~~~~~~~~~~~~~ 

 
~~~~~~~~~~~~~~~~~~~~~ 

 
 
Look at the results carefully.  The default sort order for the rows in a pivot table is alphabetical. 
Why does “movie” come up first, then (with a count of 1), instead of “amusement park”?  Why does 
“movie” come up again with a count of 53, and again with a count of 9? 

 
We have another dirty data problem, one of several we have found in this table.  What kind 
of tool would you like in Excel to be able to fix this problem? 
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We’re going to fix the problem with inconsistent entries of trip descriptions to remove the 
necessary spaces, as follows: 
 
1. First, before we leave the pivot table, let’s change the name of the worksheet containing the 

pivot table to better identify it.  Double click on the worksheet name (yours will say 
Sheet 1 or Sheet 2, depending on what we have done so far) and type Pivot-Trips. 

2. Switch to the worksheet moviebus.  Add a column called TripFix just to the right of Trip. It 
will be the new column D. 

3. When you add this column, you will be prompted with the Format Painter.  Click on it and 
choose “Clear Formatting.” This will avoid picking up the “right-justified” formatting 
of Column C (the Trip column) 

4. In cell D2, (the first data cell in the TripFix  column), enter the formula =TRIM(C2) 

5. This formula (using the TRIM function) will remove any spaces that come before or after 
the text in the cell, but it will not touch the spaces in the middle of an entry (such as the 
space between “game” and “farm” in “game farm.” 

6. Copy this formula down the column from Cell D2 to Cell D229.  The best way to copy it is to 
split the screen so you can see the top and bottom, as follows.  Highlight the contents of 
D2, hold down the SHIFT key, and click on Cell D229. Then from the Home tab, click 
on the Fill button and select Down. 

7. Now, go back to your pivot table worksheet, Pivot-Trips.  If you click inside the pivot table, the 
ribbon should now show you the Options tab (under Pivot Table Tools, above the ribbon). 

8.  Make sure that in the Show/Hide group of icons, Field List is highlighted:  

9. You should be able to see the Pivot Table Field List pane.  You will notice that TripFix may 

not be listed.  In order to get TripFix into the field list, click on the Refresh button   

10.  In the Field List pane, you will see that Trip appears under Row Labels and Count of Trip 
appears under Values.  To reset both of these areas, look at the Field List and notice that 

there is a green check next to trip.  . If you click on the check, it will 
disappear, and the Row Labels and Values areas will be cleared. 

11. You can now add TripFix to the Row Labels and also add TripFix to the Values, where it will 
appear as Count of TripFix. Drag-and-drop will work as a way to do this. 

12. You should now see a pivot table with a cleaner set of entries for the types of trips and their 
counts. 

 
 



 6 

Sorting the pivot table: 
 
Pivot tables sort in their own unique way.  First, select one cell in the column on which you want to 
sort.  In this case, it’s the first data cell in the Total column.   

 
 
Right-click on that cell, and from the menu pick Sort and then Sort Largest to Smallest. The top 
of the pivot table should look like this: 
 

 
 
 

Other Pivot Table Elements 
 
Pivot tables can be used to display data in both columns and rows. There is a great deal of 
additional functionality to pivot tables that you can explore. One useful feature is the ability to 
change the way pivot tables are displayed.  If you right-click on the pivot table, you get the set of 
menu items on the left. Choosing “Pivot Table Options” gets the screen in the middle  
 

        
 

You can move through the tabs to see how some of these options can affect the content and look 
of the pivot table. 
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Fixing the dates: 
 
We noticed earlier that the entries in the Date column were quirky, and we had an error indicator 
associated with them.  What makes them quirky is that Excel recognizes on the one hand that they 
are dates, but it does not treat them as dates for purposes of reformatting, sorting and calculations 
(for example, the ability to subtract one date from another to find out how many days elapsed  
between them). 
 

 To fix this, we are going add a column to the left of the RECNO column and call it DateFix. 
It will be the new column G.   

 In cell G2 type the formula =VALUE(B2).  Excel assigns dates a value, starting with Jan. 1, 
1900, as the value 1. Jan. 1, 2001, has a value of 36,892. Although Excel doesn’t treat the 
contents of the Date column in this spreadsheet as fully functional dates, the program does 
recognize them to some extent as dates and assigns each a value when the VALUE( ) function 
is used. 

 The next step is to reformat this value as a date. Right-click on cell G2.  In the context menu 
that appears, choose Format Cells…  Then for Category choose Date.  And for Type you can 
keep the default (month/day/year). 

 Now copy the formula from G2 down through column G to the last record in the table. 
 
The dates are now usable – in the DateFix field – if you wanted to look at the data chronologically. 
 
We’ll talk about some of the other features of pivot tables in class, and we’ll look at examples of 
generating two-way pivot tables – with columns, rows and values – that resemble crosstabs. 
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Links for stories on school field trips in the Charleston Gazette 
 

You can find these links at:  http://jclass.umd.edu/cars/secure/stories/school_trips.htm 
(You will need your CAR class login and password to access this page) 

 
Feb. 4, 2001:  “Field trip of dreams; Kanawha students flock to the movies on school time” 

Feb. 7, 2001:  Editorial:  “Day-tripping 'Rewards' out of hand” 

Feb. 9, 2001: “School officials discuss propriety of rewarding students with movies” 

Feb. 13, 2001: “Kanawha board bans movie trips unless educational” 

March 6, 2001: “Board to lists ins, outs of field trips” 

May 23, 2001: “No more movie field trips for Kanawha school kids; Putt-putt golf outings remain 
among rewards” 

Aug. 14, 2001: “Schools 'go to war' against low scores; 13 Kanawha County schools, the most 
ever, underachieved on standardized test” 

Oct. 2, 2001: “School trips in question since terrorist attacks; Parents' choice to assess risk, board 
member says” 

March 1, 2002: “Gazette's Eric Eyre wins 3 more awards” 

 
 

http://jclass.umd.edu/cars/secure/stories/school_trips.htm
http://jclass.umd.edu/cars/secure/Stories/School_Field_Trips.htm
http://jclass.umd.edu/cars/secure/Stories/School_Field_Trips_2_editorial.htm
http://jclass.umd.edu/cars/secure/Stories/School_Field_Trips_3_officials.htm
http://jclass.umd.edu/cars/secure/Stories/School_Field_Trips_4_board.htm
http://jclass.umd.edu/cars/secure/Stories/School_Field_Trips_5_rules.htm
http://jclass.umd.edu/cars/secure/Stories/School_Field_Trips_6_changes.htm
http://jclass.umd.edu/cars/secure/Stories/School_Field_Trips_6_changes.htm
http://jclass.umd.edu/cars/secure/Stories/School_Field_Trips_7_test_scores.htm
http://jclass.umd.edu/cars/secure/Stories/School_Field_Trips_7_test_scores.htm
http://jclass.umd.edu/cars/secure/Stories/School_Field_Trips_8_post_9-11.htm
http://jclass.umd.edu/cars/secure/Stories/School_Field_Trips_8_post_9-11.htm
http://jclass.umd.edu/cars/secure/Stories/School_Field_Trips_9_reporter_awards.htm
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Charleston Gazette 
Charleston, West Virginia 
February 4, 2001, Sunday 

  
“Field trip of dreams; 

 Kanawha students flock to the movies on school time” 
By Eric Eyre 

Copyright 2001 Charleston Newspapers 
  

It's 9 a.m. on a Wednesday at Marquee Cinemas, and nine Kanawha County school buses 
roar into the parking lot. 

More than 450 John Adams Junior High School students pile out of the buses and hustle inside 
to watch a movie, munch on popcorn and drink soda pop. 

Three hours later, the buses shuttle the students and teachers back to school. 

About once every three school days, some Kanawha County school is sending children to a 
movie theater, according to a Sunday Gazette-Mail analysis of school transportation records.  

The movie trips usually increase around the holidays and near the end of the school year. 
Marquee holds special morning showings on school days for Kanawha County students. 

"In December, we did one movie for a school every day," said Rob Thompson, manager at 
Marquee. "We had so many in December, my brain was fogged. It was just nonstop." 

During the school day, students also go bowling (84 times in nine months), play miniature golf 
(45 times) and shop at Town Center Mall, Kanawha Mall and the Dollar Store. 

Sometimes, the buses will make several stops - the movie theater, mall and a fast-food 
restaurant - with the same group of students during the same school day. The field trips can last 
more than six hours. 

"We don't question them," said George Beckett, the school system's transportation chief, 
noting that school principals have the final say on where students go on field trips. 

Of the 61 times Kanawha County schoolchildren went to movies during the past nine months, 
all but five trips were to Marquee Cinemas. There, they lounge in high-back chairs and watch 
movies such as "The Grinch," "102 Dalmatians," "The Emperor's New Groove" and "Mission to 
Mars." 

The county bused more than 7,700 students - a number equal to more than a third of all 
Kanawha County elementary and middle-school children - to the movies during the past nine 
months. 

"Maybe, the next time Walt Disney has a major movie release, we should shut down the school 
system for a few days to save on busing costs to Southridge," said school board member John 
Luoni. 

Kanawha County school principals defended the movie trips. 

They said many students have never been to a movie theater before. Sometimes, students 
watch movies at the cinema that they previously read as books in class, principals said. 
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But most often, principals said they hold the movies up as rewards for good behavior, grades 
and attendance. 

"Some children have to have something immediately tangible to work for," said Carla William-
son, principal at Hayes Junior High School. "It's positive reinforcement." 

Two weeks ago, a Kanawha County school bus carrying Hayes students crashed along 
Corridor G. No one was injured. 

The children were returning from Marquee, where they had watched "The Emperor's New 
Groove." Charleston newspapers and television stations reported the accident and activity. 

Williamson said no one has complained about the field trip. Fifty-nine children spent three 
hours at the movies that day. 

"The community understands what we're trying to do," William-son said. "The teachers decided 
it, and I approved it. They asked the kids what kind of reward they wanted to work for." 

The total transportation cost of the movie trips was $ 5,277 - a tiny percentage of the school 
system's transportation budget. 

The fuel costs for a single trip can run as high as $ 300. For schools near Southridge Centre, 
however, fuel costs may fall to $ 30 or below. 

Schools also must sometimes pick up the bus drivers' overtime pay. Many schools also pay for 
students' movie tickets - about $ 5 a child. 

If enough children go, Marquee throws in free popcorn and a drink. 

"We as a school system need to be careful that we do not reward with food, particularly junk 
food," said Brenda Isaac, lead nurse for Kanawha County schools. "There have got to be better 
ways to reward people." 

Each fall, schools receive money for field trips from the school system's general budget. 

Principals can spend the money as they see fit. 

They can haul students to Sunrise Museum to explore scientific principles, the state Capitol 
Complex to learn about government, the Civic Center to watch a play, and Kanawha State Forest 
and Coonskin Park to picnic and hike. 

Or they can take them to the movies. 

"I'm always amazed we have money for this kind of activity," said school board member Pete 
Thaw. "Why don't we spend the money for instruction for these children?" 

In their reviews of school systems in West Virginia, state education auditors sometimes cite 
schools for shortchanging students on instructional time. 

"There's a certain amount of time required each day for instruction," said Donna Davis, deputy 
director of the state Office of Education Performance Audits. "If the school is having a number of 
activities that are not academically related, then it might lead to a noncompliance." 

Davis said the agency wouldn't necessarily flag a school that took large numbers of students to 
a bowling alley or movie. 
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The activities might be linked to the school's curriculum. Students may watch a movie based 
on a book they've read. Or the gym teacher may lead a unit about bowling and follow it with a trip 
to the nearest bowling alley. 

Joyce Embrey, principal at Midland Trail Elementary, said 30 students went bowling for that 
reason last week. The trip also was a reward for students who had doubled the number of books 
they normally read as part of a school reading program. 

"Some of them had never been bowling," Embrey said. 

When principals need a bus for a field trip, they must fill out a "curricular" trip request form and 
submit it to one of five Kanawha County school bus terminals. They also may state a reason for the 
trip. 

For movie trips, some principals put down "academics." One stated, "fun and games." But the 
majority list "reward" as the reason for the trip to the movies, bowling alley, miniature golf center or 
roller rink. 

Some child psychiatrists criticize principals and teachers who dangle rewards over students for 
good behavior. They say such measures make children even more dependent on others for 
approval and recognition. Such students lack self-confidence and responsibility. 

Capital High School Assistant Principal Clinton Giles said he doesn't like offering rewards for 
good behavior and attendance. 

But he said societal and cultural changes have created a generation of students who only 
respond to: "What's in it for me?" 

"It's no longer the carrot and the stick," Giles said. "It's carrot, carrot, carrot."  


